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Renesas Synergy™ Platform 

Renesas Synergy™ Platform Pin Configurator Usage  
Introduction 
This application note describes how to use pin configurator for Renesas Synergy™ Platform in e2 studio or 
the IAR Embedded Workbench (IAR EW for Synergy). 

Objectives 
The objective of this application note is to help users to be familiar with the procedure of configuring pins of 
the Synergy project by using the Pin Configurator of e2 studio or IAR EW for Synergy. 

Required Resources 
The procedure in this application note applies to all Renesas Synergy™ devices and development boards. 
Before following the procedure in this application note, make sure the following resources are available 

• A PC running Microsoft® Windows® 7 or 10 with the following Renesas software installed: 
• IAR EW for Synergy v8.23.3 or e2 studio v7.3.0 (or later) 
• Synergy Software Package (SSP) v1.6.0 or later 
• Renesas Synergy™ Standalone Configurator (SSC) v7.3.1 (only for IAR EW for Synergy) 
 
You can download the required Renesas software and view the installation instruction from the Renesas 
Synergy™ Platform (https://www.renesassynergy.com). 

Operating Environment 
Target devices Development Kit for Renesas SynergyTM S7G2. 

Development Kit for Renesas SynergyTM S124. 
Development Kit for Renesas SynergyTM S3A7. 

SSP SSP v1.6.0 or later 
IDE e2 studio v7.3.0 (or later) or IAR EW for Synergy v8.23.3 
Toolchains GNU ARM® Compiler GCC_7.2.1.20170904 (included in e2 studio) 

IAR EW for Synergy  
 
  

https://www.renesassynergy.com/
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1. Generating a Synergy Project 
This chapter describes how to create a Synergy C project used for demonstrating the operation of pin 
configurator. If you already have a Synergy project, please skip to chapter 2. 

1.1 Generating a Synergy Project using e2 studio 
1. Invoke e2 studio and launch a workspace. Select File → New → Synergy C Project to open the project 

creation wizard.  

 

Figure 1.   New Synergy C Project 

2. Select Renesas Synergy C Executable Project and click Next. 

 

Figure 2.   Project template 
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3. In the project creation wizard, input project information: 
A. Project name: enter a name, for ex: Pin_Configurator_Example. 
B. Use default location: Checked. 
C. Toolchain: GCC ARM Embedded. 
D. License: In case license file is not input: 

a. Click Change license file to open the Synergy License dialogue box.  
b. Click […] button and browse to this location for license: {e2 studio installed folder} 

\internal\projectgen\arm\licenses and select the license file in XML format. This 
license file is available only when SSP is installed. 

E. Click the Next button to continue. 

      

 

Figure 3.   Synergy Project Creation Wizard 



Renesas Synergy™ Platform Renesas Synergy™ Platform Pin Configurator Usage 

R20AN0512EU0101  Rev.1.01  Page 5 of 37 
Sep.30.19  

4. In the Device Selection dialog, input device and tool information: 
A. Board: S7G2 DK 
B. Toolchain version: Latest GNU compiler approved for use with Renesas Synergy. Currently 

7.2.1.20170904 
C. Other fields are kept as default as shown in the figure below. 
D. Click Next button to continue. 

   

 

Figure 4.   Device Selection 
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5. In the project templates dialog, select project type: Blinky and click Finish to create project. 

    

 

Figure 5.   Project Templates 

6. You may be prompted to open the Synergy Configuration perspective. Click Yes to open the 
perspective. 

 

Figure 6.   Open Synergy Configuration Perspective 
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7. New Synergy Project is successfully created and launched in Synergy Configuration perspective. There 
are 3 panes in this perspective: Project Explorer, Synergy Configuration, and Package. 

 

 

Figure 7.   New project opened in “Synergy Configuration” Perspective 

1.2 Generating a Synergy Project using IAR EW for Synergy 
1. In the IAR EW for Synergy menu, choose Renesas Synergy → New Synergy Project… 

  

Figure 8.   Create New Project 
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2. In the Save Workspace As dialog box that appears, choose a folder to save the workspace in and enter 
the workspace name: MyWorkspace and click Save. 

 

Figure 9.   Save Workspace 

3. In the Renesas Synergy Settings dialog box that appears, specify:  
A. Location where Renesas Synergy SSC/SSP is installed: C:\Renesas\Synergy\SSC_[SSC 

version] (default installation folder). 
B. License file: C:\Renesas\Synergy\SSC_[SSC 

version]\internal\projectgen\arm\licenses 
a. Note 1: The SSP license MUST be installed under the SSC_[SSC version] folder.  
b. Note 2: If the license is installed in e2 studio, user may copy the [internal] folder of e2 studio 

(C:\Renesas\e2studio \internal\projectgen\arm\Licenses) to the SSC [SSC 
version] folder. 

C. Replace encrypted files with decrypted files: unchecked 
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Figure 1-10 Renesas Synergy Settings 

4. In the Save As dialog box that appears, choose a folder that save the project and enter the project name: 
Pin_Configurator_Example and click Save. 

  

Figure 11.   Save project 
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5. When the Synergy Standalone Configurator opens, specify: 
A. SSP version: 1.6.0 or later 
B. Board: S7G2 DK 
C. Device: R7FS7G27H2A01CBD 
D. Click Next 

      

Figure 12.   Device Selection 

6. In the Project Template Selection, select Blinky. Click Finish. 

      

Figure 13.   Select project template 
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7. The Synergy Standalone Configurator window will be launched.   

  

Figure 14.   Synergy Configurator 

8. We will work with the above configurator later. For now, switch back to IAR EW for Synergy window. The 
Synergy project is generated successfully. 

  

Figure 15.   Project is created 
2. Launching Pin Configurator 
This chapter describes how to launch the Pin Configurator using e2 studio or IAR EW for Synergy. 
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2.1 Launching Pin Configurator using e2 studio 
1. In e2 studio, double click the file Configuration.xml in Project Explorer to open the Synergy 

Configuration Editor.  
2. When the Synergy Configuration Editor launches, the first page displayed is the Summary page. Click 

the Pins tab to open the Pin Configurator page. 

 

 

Figure 16.   Launch Synergy Configuration Editor in e2 studio 

2.2 Launching Pin Configurator using IAR EW for Synergy 
The Synergy Standalone configurator has been opened in step 8 of section 1.2.  

If the configurator is closed, in the IAR EW for Synergy menu, choose Renesas Synergy → Configurator… 
to open it again. 

You can also click on the  icon on the toolbar to open the configurator. 

   

Figure 17.   Launch Synergy Configuration Editor in IAR EW for Synergy 
When launching the Synergy Configuration Editor, the page displayed is the [Summary] page. Click the Pins 
tab to launch the Pin Configurator page. 
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Figure 18.   Launch Pin page 

3. Pin Configurator GUI 
The Pin Configurator allows you to configure the pins in the Synergy project. The GUI of the Pin 
Configurator in e2 studio and IAR EW for Synergy are the same. It consists of 4 main parts:  

1. Select pin configuration 
2. Pin Selection 
3. Pin Configuration 
4. Package 
 

 

 

Figure 19.   Pin Configurator GUI 
The details and how to use each part of the Pin Configurator will be described in the following chapters. 
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4. How to use the Select pin configuration pane 
The Select pin configuration pane is used to select the pin configuration file. A pin configuration file 
represents the setting for a specific Synergy device. When modifying the pin setting, the changes will be 
saved to the pin configuration file.  

4.1 GUI Introduction 
The Select pin configuration pane consists of the following components: 
1. configuration drop-down list: allows you to select an existing pin-configuration file or create a new 

configuration file. 
2. Generate data: 

A. Checkbox: checked by default. Generate pin configuration to source code. 
B. Text box: contains the name of the data structure to be generated for the pin-configuration. The 

default data structure g_bsp_pin_cfg is necessary for the project as it defines initial pin 
configuration. Renaming will cause build error but adding new data structure is possible by following 
chapter 4.3.  

3. Pins Tutorial link: open a tutorial video on web browser. 

4. Select device button : change the device of the pin configuration. 

5. Import button : import an existing (compatible) Pin Configuration into the Synergy project 
 

 

Figure 20.   Select pin configuration 

4.2 Using Single Configuration file (default) 
When a new Synergy project is created, a pincfg file for the selected device and the pincfg contained in the 
selected BSP will be generated. These pin-configuration files are named after the device name 
(R7FS7G27H2A01CBD.pincfg) and board name (S7G2-DK.pincfg).  

In e2 studio, they are displayed in the Project Explorer window. 

  

Figure 21.   Pin configuration files in e2 studio 
In IAR EW for Synergy, the pin configuration files are not displayed in the Workspace window. To view 
them, open Windows Explorer and go to the project folder. 
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Figure 22.   Pin configuration files in IAR EW for Synergy 
Normally, you can ignore the R7FS7G27H2A01CBD.pincfg and perform every pin configuration with S7G2-
DK.pincfg. 

 

 

Figure 23.   Only the S7G2-DK.pincfg is used  

4.3 Using Multiple Pin-Configuration files 
A Synergy project usually only needs to use one pin-configuration file. However, in some applications, 
multiple pin configuration files are needed. It allows dynamic switching of pin configurations during run time, 
for example, for setting different power modes. 

The multiple pin configurations will be created in different data structures. The following steps describe how 
to create a new pin configuration file manually.  
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1. Select New default configuration… in the configuration drop-down list to create a new configuration 
file.  

2. Rename the newly created configuration file as you like. 

 
 

  

Figure 24.   Create a new pin-configuration file 

3. The new configuration file is automatically added to the Select pin configuration drop-down list.   

  

Figure 25.   New configuration file is added to the drop-down list 

4. Select NewName.pincfg in the drop-down list and enter a unique name for it in the text box. For 
example: NewConfig. 

 

Figure 26.   Unique name for the new pin configuration 

4.4 Importing a Pin Configuration 
User can import an existing (compatible) pin configuration into a Synergy project. This is a ‘partial’ import, 
which means that the new setting will be merged to the current settings. The following steps describe how to 
use the import function. 

1. Select a pin configuration file to import to. In this case, select the NewName.pincfg created in section 
4.3. 

 

Figure 27.   Select NewName.pincfg 
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2. Click on the  button to open the Import Pin Configurations from File dialog 

 

Figure 28.   Click the Import button 

3. Select file to import: 
A. In e2 studio, click on Workspace... to select file from user’s workspace or click on File System... to 

select file from file system.  
B. In IAR EW for Synergy, click on File System... to select file from file system. 
In this example, click File System..., go to the Project Folder and select S7G2-DK.pincfg to import 
from it. 

 

Figure 29.   Import Setting from S7G2-DK.pincfg 
4. Click OK. If there is no conflict, the settings of S7G2-DK.pincfg will be imported to NewName.pincfg. 
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5. If conflicts exist, the import function points out conflicts and provides the following options to the user: 
A. Cancel the import operation 
B. Ignore the conflicts and import the conflicting settings anyway 
C. Continue the import operation without importing the conflicting settings. 

  

Figure 30.   Conflicts found during the import process 

4.5 Changing the selected device of Pin Configuration file 
User can change the device in a pin configuration file. The following steps describe how to use this function. 

1. Select a pin configuration file to change the device. In this case, select the NewName.pincfg created in 
section 4.3. 

 

Figure 31.   Select pin configuration file 



Renesas Synergy™ Platform Renesas Synergy™ Platform Pin Configurator Usage 

R20AN0512EU0101  Rev.1.01  Page 19 of 37 
Sep.30.19  

2. Click the  button to open the drop-down list and select the desired device to change to. In this example, 
we change the device from renesas.s7g2_bd to renesas.s7g2_fc. 

 

Figure 32.   Change the selected device 

3. The MCU package of the new device selected will be displayed in the Package view. 
Note: This change only affects the currently selected pin configuration. The device of other pin configurations 
remains unchanged.  

In e2 studio, the Package view is opened by default in the Synergy Configuration perspective. If it is 
closed, select Window → Show View → Pin Configurator → Package to open it. 

 

Figure 33.   Package view is updated after changing device 
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4. If conflicts exist, the device changing function points out conflicts and provides the following options to the 
user: 
A. Cancel the device changing operation. 
B. Ignore the conflicts and continue to change the device, conflicting settings will be imported. 
C. Click OK to continue changing device. Conflict settings will not be imported. 

 

Figure 34.   Conflicts found during changing device 
5. To continue chapter 5, change the pin configuration from NewName.pincfg back to S7G2-DK.pincfg. 
 

5. How to use the Pin Selection pane 
The Pin Selection pane shows all of the pins that are available for the device. The pins are categorized into 
groups - “Ports”, “Peripherals”, and “Other Pins”. 

Note: The usage of Pin Selection is the same for IAR EW for Synergy and e2 studio. 
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1. The Pin Selection pane contains: 
A. Filter text box 
B. Clear button 
C. Expand All button 
D. Collapse All button 
E. Pins tree which contains the categorized pins 

 

Figure 35.   Pin Selection Pane 

2. Typing text in the filter text box will list out the pins that contain the text. Clicking on the Clear button will 
clear the text box and the filter results. 

 

Figure 36.   Use the filter text box 

3. The Expand All button and the Collapse All button will expand and collapse the pins tree respectively. 

 

Figure 37.   Use the Expand All and Collapse All button 

Filter text box 

Clear  

Collapse 
All  

Expand 
All  

Pins tree  
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4. Selecting a port or peripheral in the Pin Selection pane will show its settings in the Pin Configuration 
area. It can then be modified and set up as necessary. The icon of the selected pin will also be marked 
with blue border in the Package view. 

 

Figure 38.   Select a Port in Pin Selection pane 

6. How to use the Pin Configuration pane 
The Pin Configuration pane allows user to change the setting of Ports and Peripherals that are selected in 
the Pin Selection pane.  

Note: The use of Pin Configuration is the same for IAR EW for Synergy and e2 studio. 

1. The Pin Configuration pane contains: 
A. Lock/Unlock Settings button 
B. Setting area 

 

Figure 39.   Pin Selection Pane 

Lock/Unlock Settings 
Setting Area 
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2. Click on the Lock/Unlock Setting button to disable/enable the modification of the selected item in the 
Pin Configuration pane. 

 

Figure 40.   Lock a selected Pin 
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3. Click on the  (follow connection) button in the setting area of a connected pin to go to the setting area 
of the corresponding peripheral and vice versa. 

 

Figure 41.   Switching between Pin and Peripheral setting 

4. If a module setting is configured incorrectly, that module will be marked with the error symbol in the Pin 
Selection pane and Pins Configuration pane. The details of the conflicts will be shown in the Pin 
Conflicts or Problems window. All conflicts need to be resolved before generating the source code. 
For example, in DEBUG0 module, change the TCK to None to make the setting wrong. After finishing, 
change it back to P300. 
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Figure 42.   Error in Pin Configuration 

5. After the pins are configured correctly, press Ctrl + S to save the changes. 

 

Figure 43.   Unsaved setting  

7. How to use the Package View 
The Package view displays all available pins in the device along with their attributes. 

Note: The usage of Package view is the same for IAR EW for Synergy and e2 studio. 

In e2 studio, the Package view is opened by default in the Synergy Configuration perspective. If it is 
closed, select Window → Show View → Pin Configurator → Package to open it. 

1. The Package view contains: 
A. Pins table 

Display all the pins along with their attribute. The Pins attribute are shown as background color and 
label. 

B. Zoom In, Zoom Out button 
Zoom in and zoom out the Pins table 

C. Select Attribute for Background Color button 
Change the background colors of the pin according to the in attributes selected. 

D. Select Attribute for Labels button 
Switch between the module name and symbolic name of the pins. 

E. Description text 
Describe the color being used in the Pins table. 

An asterisk (*) indicates 
that the changes in setting 

is not saved. Press 
[Ctrl+S] to save it 
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Figure 44.   Package View GUI 

2. When an item in the Pin Selection is selected, all the corresponding pins will be bordered with blue line.  
In this example, PB04, PB05, PB02 and PB03 are used by the Serial Communications Interface (SCI8), 
thus they are marked by blue line in the package view. 

 

Figure 45.   Pins of SCI8 are marked with blue line in Package view 

Zoom In, 
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for Labels 
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3. Selecting a pin in the Package view will show its setting in the Pin Configuration pane. 

 

Figure 46.   Select a Pin in Package view 

4. When a pin is configured correctly, it is marked with an  (OK) symbol. If it is incorrectly configured, it is 
marked with  (Error) symbol. 

 

Figure 47.   Correct and error symbol in Package view 

Error pin 
setting 

Correct pin 
setting 
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5. You can change the background color of the pins based on the selected attribute. Click on the  button 
on the top right corner of Package view to show the drop-down list: 
A. Connection Status (default): Error, Warning, OK 
B. Drive Capacity: High, Medium, Low 
C. Mode: Analog Mode, Disable, IRQ Mode, Input Mode, Output mode (Initial High), Output mode (Initial 

Low), Peripheral mode. 
D. Output Type: CMOS, n-ch open drain 
E. Pull Up: None, input pull-up 
Selecting one item from the list will change the background color of the Pins table. The colors will be 
described in the Description Text area. 

 

Figure 48.   List of Pins attributes 
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6. You can also switch between the module name and symbolic name of the pins by clicking on the  
button on the top right corner of Package view: 

 

Figure 49.   Module name and Symbolic name in Package view 
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8. Generating Pin Configuration source code 
8.1 Generating source code in e2 studio 
1. After configuring the pins, you can click on the Generate Project Content button to generate the 

necessary pin configuration source files for the project 

 

Figure 50.   Generate Project Content button 
2. The source code for pin Configuration is generated at synergy_cfg/ssp_cfg/bsp/bsp_pin_cfg.h 

and src/synergy_gen/pin_data.c. 
Note: Do not edit these files as they will be overwritten when building the project and whenever the 
Generate Project Content button is pressed. 
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Figure 51.   Source code for Pin Configuration 
3. In case of using multiple pin configurations, different data structures can be created in pin_data.c. 

This allows dynamic switching of pin configurations during run time (for example, for different power 
modes). 
In this example, we use two pin configuration files to generate two data structures. 

 

Figure 52.   Different data structures for different Configurations 
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4. Each pin configuration will have its own CSV file which contains all pin configurations. The CSV files can 
be found at synergy_cfg/ssp_cfg/bsp/*.csv.  

 

Figure 53.   CSV files 

8.2 Generating source code in IAR EW for Synergy 
1. After configuring the pins, you can click on the Generate Project Content button to generate the 

necessary pin configuration source files for the project. 

  

Figure 54.   Generate Project Content button 
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2. The source code is generated at <ProjectDir>\Synergy\Source 
Files\src\synergy_gen\pin_data.c. 

  

Figure 55.   Source code for Pin Configuration 
3. In case of using multiple pin configurations, different data structures can be created in pin_data.c. This 

allows dynamic switching of pin configurations during run time (For example, for different power modes). 
In this example, we will use S7G2-DK.pincfg and NewName.pincfg to generate two data structures. 
The data structures are named after the unique names that were entered in the text box in previous 
steps: g_bsp_pin_cfg and NewConfig 

 

Figure 56.   Different data structures for different Configurations 
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4. Each pin configuration will have its own CSV file which contains all pin configurations. The CSV files are 
not shown on the Workspace window, but you can open Windows Explorer and locate the file at 
<ProjectDir>\synergy_cfg\ssp_cfg\bsp\. 

 

Figure 57.   CSV files 
9. Additional Information 
For more information on the Pin Configurator or other Synergy Configurator sections, please refer to 
e2 studio Help Contents. 

Select Help  Help Contents, go to Synergy Contents  Synergy configuration editor to open the topic 
related to the Synergy Configurator. 
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Figure 58.   Synergy Topic in e2 studio Help Contents 
For introduction and installation guide of IAR EW for Synergy, refer to IAR EW for Synergy Help Contents 

Select Help  Contents…, go to IAR Embedded Workbench(R) for Renesas Synergy(TM). 

 

Figure 59.   Synergy Topic in IAR EW for Synergy Help Contents 
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Website and Support 
Visit the following vanity URLs to learn about key elements of the Synergy Platform, download components 
and related documentation, and get support. 

 
Synergy Software   www.renesas.com/synergy/software 
 Synergy Software Package www.renesas.com/synergy/ssp 
 Software add-ons  www.renesas.com/synergy/addons 
 Software glossary  www.renesas.com/synergy/softwareglossary 

Development tools  www.renesas.com/synergy/tools 
 

Synergy Hardware   www.renesas.com/synergy/hardware 
 Microcontrollers   www.renesas.com/synergy/mcus 
 MCU glossary   www.renesas.com/synergy/mcuglossary 
 Parametric search  www.renesas.com/synergy/parametric 

Kits    www.renesas.com/synergy/kits 
 

Synergy Solutions Gallery  www.renesas.com/synergy/solutionsgallery 
 Partner projects   www.renesas.com/synergy/partnerprojects 

Application projects  www.renesas.com/synergy/applicationprojects 
 
Self-service support resources:  

Documentation    www.renesas.com/synergy/docs 
Knowledgebase    www.renesas.com/synergy/knowledgebase 
Forums     www.renesas.com/synergy/forum 
Training    www.renesas.com/synergy/training 
Videos    www.renesas.com/synergy/videos 
Chat and web ticket   www.renesas.com/synergy/resourcelibrary 

 

  

https://www.renesas.com/synergy/software
https://www.renesas.com/synergy/ssp
https://www.renesas.com/synergy/addons
https://www.renesas.com/synergy/softwareglossary
https://www.renesas.com/synergy/tools
https://www.renesas.com/synergy/hardware
https://www.renesas.com/synergy/mcus
https://www.renesas.com/synergy/mcuglossary
https://www.renesas.com/synergy/parametric
https://www.renesas.com/synergy/kits
https://www.renesas.com/synergy/solutionsgallery
https://www.renesas.com/synergy/partnerprojects
https://www.renesas.com/synergy/applicationprojects
https://www.renesas.com/synergy/docs
https://www.renesas.com/synergy/knowledgebase
https://www.renesas.com/synergy/forum
https://www.renesas.com/synergy/training
https://www.renesas.com/synergy/videos
https://www.renesas.com/synergy/resourcelibrary


Renesas Synergy™ Platform Renesas Synergy™ Platform Pin Configurator Usage 

R20AN0512EU0101  Rev.1.01  Page 37 of 37 
Sep.30.19  

Revision History 

Rev. Date 
Description 
Page Summary 

1.00 Jan.01.19 — First release document 
1.01 Sep.30.19 — Updated for SSP v1.6.0 

 

 



 

© 2019 Renesas Electronics Corporation. All rights reserved. 

Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.  

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.4.0-1  November 2017) 
 

Corporate Headquarters  Contact information 
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